## Table of Contents

Navigating TE ................................................................. 4
  Install and Open TE Online ........................................ 4
  Explore Menus and Submenus ..................................... 5
Finding Information .......................................................... 8
  Understanding the Relationship of Records in TE .......... 8
  Customizing Lists of Records ....................................... 8
  Using the Navigator ...................................................... 13
  Editing Information ...................................................... 16
Adding Records .................................................................. 18
  Steps to Add Sites ......................................................... 18
  Steps to Add and Manage Users ................................... 21
    Group Access Rights .................................................. 24
  Steps to Add Student Records ...................................... 26
  Steps to Add Test Records .......................................... 28
  Steps to Add Class Records ......................................... 30
    Class Definitions ....................................................... 30
    Class Instance .......................................................... 34
    Import Class Data ........................................................ 40
  Steps to Add and Link Personnel Records .................... 41
    Personnel Registration ................................................. 41
    Functional Roles ....................................................... 43
Scanning Data .................................................................. 47
  Prepare Records for Scanning ....................................... 47
  Steps to Scan Records .................................................. 49
  Steps to Override Scanning Options ............................... 52
  Steps to Edit Scanned Data ........................................... 53
  Steps to Import Scanned Records ................................. 55
Quick References to Locating Scanned Information in TE.................................56
Tracking Results...............................................................................................59
Testing Guidelines ...........................................................................................59
Pretests .............................................................................................................59
Post-tests ..........................................................................................................59
Multiple Modalities Paired Tests .....................................................................59
Test Scores Outside Accurate Range .................................................................60
Scores Below the Accurate Range (*)...............................................................60
Conservative Estimate Scores (•)....................................................................60
Customizing the Tests Lister ............................................................................61
The Report Generator .......................................................................................66
Report Setup Navigator ....................................................................................66
    General Settings ...........................................................................................67
    Listers Selection ...........................................................................................69
    Report Selection ...........................................................................................69
Report Setup Toolbar .......................................................................................69
Report Viewer ...................................................................................................70
Reporting Session Toolbar .............................................................................70
Saving Reports ..................................................................................................72
Using Drill Down ...............................................................................................73
Displaying Data as Charts and Graphs ..............................................................73
Printing Reports from Listers ..........................................................................74
Reports Manager ...............................................................................................75
My Reports .........................................................................................................75
Report Locator Wizard .....................................................................................75
Generating Instructional Reports ......................................................................76
CASAS eTests Reports .....................................................................................77
Next-Assigned Test (NAT) ...............................................................................77
Personal Score Report (PSR) ...........................................................................78
Contents

Skills Profile Reports ..................................................................................................................79
  Student Individual Skills Profile (ISP) ....................................................................................79
  Skills Profile – Class Summary (ISPS) ....................................................................................80
Content Standards Reports ..........................................................................................................81
  Content Standards – Student Performance (SCS) .................................................................81
  Content Standards – Class Performance Summary (SCSS) ..................................................83
Competency Performance Reports ..............................................................................................84
  Competency Performance – Student (SCP) ...........................................................................84
  Competency Performance – Class (SCPS) .............................................................................85
Learning Gains Reports .............................................................................................................86
  Learning Gains – Student (LG) .............................................................................................86
  Learning Gains – Class Summary (LGS) .................................................................................87
Test Response Reports .............................................................................................................88
  Test Response – Class Profile (CPL) .....................................................................................88
Test History – Student Test Summary by Class (STS) ...............................................................89
Steps to Exit TE ...........................................................................................................................90
CASAS Contact Information .....................................................................................................91

Download Help Documentation at Home > Training and Support
Navigating TE

To use the many features of TOPSpro Enterprise (TE), you will need to know how to find them by navigating through the menus. TE uses the same type of menu system that you see in most Windows-based applications.

Install and Open TE Online

To access TOPSpro Enterprise Online (TE) for the first time, launch the web browser and enter the URL for the CASAS Online System your program uses.*

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Step 1](image1.png) | Access TE in one of three ways, from the –
|      | ![Step 2](image2.png) | 1. Web browser
|      | ![Step 3](image3.png) |   • Click Install TE Client if first access on local machine. |
|      | ![Step 4](image4.png) | 2. Taskbar icon |
|      | ![Step 5](image5.png) | 3. Desktop icon |
| 2.   | ![Step 6](image6.png) | Click the Server field down-arrow and from the drop-down menu,
|      | ![Step 7](image7.png) |   • Select the Server for your online account.*
|      | ![Step 8](image8.png) |   • Enter your Agency ID.
|      | ![Step 9](image9.png) |   • Enter your User name.
|      | ![Step 10](image10.png) |   • Enter your Password. |
|      | ![Step 11](image11.png) |   • Click Connect. |

*Server Use any modern web browser

*Global [https://etestsonline.org/html5/#/](https://etestsonline.org/html5/#/)
Explore Menus and Submenus

TE opens with an empty screen and a menu bar along the top. Not all agencies using the CASAS Online System have access to all menus and data functions, and not all users have access to data or rights to edit records. Access rights depend on the TE Package and user rights granted by the agency.

Visit the CASAS website for more information about Assessment and Database Management Features to understand ‘basic’ vs. ‘enhanced’ access to the CASAS Online System.

Take a Highlights Tour to look at some menu features and to see how TE organizes menus.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td><img src="image1.png" alt="Screen 1" /></td>
<td>• All data and reports display on the screen from accessing the Menu bar along top left.</td>
</tr>
<tr>
<td>2.</td>
<td><img src="image2.png" alt="Screen 2" /></td>
<td>• Top right displays,&lt;br&gt;  o Logged-on User.&lt;br&gt;  o Application Version.&lt;br&gt;  o General screen Controls.&lt;br&gt;  o Pages tab to clear your screen(s).</td>
</tr>
<tr>
<td>3.</td>
<td><img src="image3.png" alt="Screen 3" /></td>
<td>• Click the TE Icon at top left of your screen.&lt;br&gt;  • Before exiting TE, it’s best to –&lt;br&gt;  o Disconnect your TE Client to close connection with the server on your local machine.&lt;br&gt;  • Click Options…</td>
</tr>
<tr>
<td>Step</td>
<td>Screen</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 4.   | ![General tab](image) | • Look at the **General** tab.  
  o **Interactive Timeout Interval**  
    ▪ Adjust # of minutes before the TE Client suspends activity.  
    ▪ Applies to TE Client on the local machine only. |
| 5.   | ![On Start tab](image) | • Click the **On Start** tab.  
  o **Remaining WTUs**  
    ▪ Set a TE Client reminder when # of WTUs reaches a minimum set by users.  
    ▪ Applies to TE Client on local machine only. |
| 6.   | ![Edit / View tab](image) | • Click the **Edit / View** tab.  
  o **Name Options.**  
    ▪ Set option for entering names.  
    ▪ Apply option to correct names.  
    ▪ Applies to TE Client on local machine only.  
  • To close the **Options** window,  
    o Click the **Red X Box** at top right. |
| 7.   | ![View menu](image) | • Click the **View** menu.  
  o **Screen Display**  
    ▪ **Normal** is the default.  
    ▪ Adjust for viewing on local TE Client. |
### Navigation

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8.   | ![Organization menu](image) | - Highlight or click the **Organization** menu.  
  - **Sub-menus** contain detailed information about the organizational setup of an online account.  
- Click the **Records** menu.  
  - **Menu Categories** identify groups of lists with records for tracking program and student activity.  
  - **Sub-menus** identify the type of records. |
| 9.   | ![Reports menu](image) | - Highlight or click the **Reports** menu.  
  - **Menu Categories** identify groups of reports that help programs meet a wide variety of reporting needs.  
  - **Sub-menus** identify the type of report. |
| 10.  | ![Tools menu](image) | - Highlight or click the **Tools** menu.  
  - **Sub-menus** list operations for managing data.  
- Highlight or click the **Help** menu.  
  - **Release Notes** are included with each update to the Online System.  
  - Review **Notes** for important new features and enhancements as well as any necessary fixes. |
Finding Information

The online system functions like a web browser to fetch information and display on the screen in tabbed pages. Using tabs as a navigational tool is a feature that allows you to switch between multiple pages of information.

Understanding the Relationship of Records in TE

TOPSpro Enterprise is a relational database that contains a collection of interrelated records, which stores information and relates records by a common element. In TE, that element is the identification field. For a student, that field contains the identification code unique to the learner that links all records related to the learner. The graphic below presents this concept.

The Student Identification (ID) code provides the minimum information for TE to add a student record. The student Demographics record is the "parent" record for all other learner-related records. Every time you add another record, TE links the ID to the corresponding student, and creates a new record. These other records contribute additional information to the student and are the “child” records in the database. TE connects the parent and child records by ensuring that they all include one common variable – the Student Identification (ID) code.

Customizing Lists of Records

TE uses Listers to display lists of records. Each lister name indicates the information that it contains. Listers are like spreadsheets but in electronic form. You may sort, filter, add, hide, and organize columns, set advanced filtering options, print, and export the information displayed.
Using the student as an example, let’s customize the Demographics lister.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Screen 1](image1.png) | - From the Menu bar at top,  
      - Click Records.  
      - Select Students.  
      - Click Demographics. |
| 2.   | ![Screen 2](image2.png) | - A tabbed page opens to the list of Demographics records with a Toolbar along the top.  
      - Records display for students having activity in the Current Program Year (July 1 – June 30).  
      - Sorts on Student ID.  
      - Most Column Headers have Up/Down arrows and Filter icons. |
| 3.   | ![Screen 3](image3.png) | - To sort by Name,  
      - Click the Name column UP arrow.  
      - By default, the Name column sorts by First name. |
| 4.   | ![Screen 4](image4.png) | - Each list of records has its own default Schema, or Column Configuration.  
      - You may change the configuration of columns and save the Schema on your TE Client.  
      - To split the Name column into First, Middle, and Last name columns,  
        - Point your mouse in the Name column header.  
        - Right mouse-click.  
      - From the drop-down menu listing additional columns available in the Demographics lister,  
        - Click Show First Name. |
### Step 5

**Screen:**
- Demographics
- 4908 - Rolling Hills Adult School (RHAS)

<table>
<thead>
<tr>
<th>Site</th>
<th>Student ID</th>
<th>First Name</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>Rick</td>
<td>Rick Williams</td>
</tr>
<tr>
<td>02 - RHAS: Sout...</td>
<td>005205242</td>
<td>Richard</td>
<td>Richard Williams</td>
</tr>
</tbody>
</table>

**Description:**
- Now you will see the First name has its own column.
- Repeat these steps to add a Middle name and Last name column.

### Step 6

**Screen:**
- Demographics
- 4908 - Rolling Hills Adult School (RHAS)

<table>
<thead>
<tr>
<th>Site</th>
<th>Student ID</th>
<th>Name</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>First Name</td>
<td>Name</td>
</tr>
<tr>
<td>02 - RHAS: Sout...</td>
<td>005205242</td>
<td>First Name</td>
<td>Name</td>
</tr>
</tbody>
</table>

**Description:**
- Now that the Name column is split into three columns for First, Middle, and Last name, you no longer need the column.
- Right mouse-click in the Name column header.
  - Select Hide Full Name.

### Step 7

**Screen:**
- Demographics
- 4908 - Rolling Hills Adult School (RHAS)

<table>
<thead>
<tr>
<th>Site</th>
<th>Student ID</th>
<th>First Name</th>
<th>Middle Name</th>
<th>Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>Rick</td>
<td></td>
<td></td>
</tr>
<tr>
<td>02 - RHAS: Sout...</td>
<td>005205242</td>
<td>Richard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>Traylor</td>
<td></td>
<td>Ford</td>
</tr>
</tbody>
</table>

**Description:**
- The Name column is now hidden from the list.
- You may unhide any column to display again in the list of records.
- Listers may be Reset to Defaults at any time.

### Step 8

**Screen:**
- Demographics
- 4908 - Rolling Hills Adult School (RHAS)

<table>
<thead>
<tr>
<th>Site</th>
<th>Student ID</th>
<th>First Name</th>
<th>Middle Name</th>
<th>Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>Rick</td>
<td></td>
<td></td>
</tr>
<tr>
<td>02 - RHAS: Sout...</td>
<td>005205242</td>
<td>Richard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>Traylor</td>
<td></td>
<td>Ford</td>
</tr>
</tbody>
</table>

**Description:**
- Reordering columns will further customize the list of Demographics records for your TE Client.
  - Left click-and-hold your mouse in the Last Name column header.
  - While holding, drag the Last Name column left of the First Name, and then release your mouse.

### Step 9

**Screen:**
- Demographics
- 4908 - Rolling Hills Adult School (RHAS)

<table>
<thead>
<tr>
<th>Site</th>
<th>Student ID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Middle Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>Williams</td>
<td>Rick</td>
<td></td>
</tr>
<tr>
<td>02 - RHAS: Sout...</td>
<td>005205242</td>
<td>Williams</td>
<td>Richard</td>
<td></td>
</tr>
<tr>
<td>01 - RHAS: Nor...</td>
<td>005205216</td>
<td>Ford</td>
<td>Traylor</td>
<td></td>
</tr>
</tbody>
</table>

**Description:**
- The Demographics lister now displays names in a Last, First, and Middle name column configuration.
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 10.  | ![Image](image1.png) | - In the **Last Name** column header  
  o Click the **UP** arrow to sort alphabetically. |
| 11.  | ![Image](image2.png) |  
  1. First, sort on **Last Name**.  
  2. Second, sort on **First Name**.  
  3. Third, sort on **Middle Name**.  
  
  **Note!** Adding **Gender** and **DOB** columns helps with identifying any duplicate records of the same student.  
  
  **Suggestion:** Configure and presort columns:  
  1. Click the **UP** arrow in the **Last Name** column header.  
  2. Click and hold the **Shift** key on your keyboard, and then click the **UP** arrow in the **First Name** column header.  
  3. Click and hold the **Shift** key again, and click the **UP** arrow in the **Middle Name** column header.  
  - Release the **Shift** key. |
| 12.  | ![Image](image3.png) |  
  - To save the configuration of your columns,  
  o Click the **More** button from the **Toolbar** at top right for ‘more’ buttons.  
  o Click **Edit Schema**.  
  o Click **Save**.  
  
  **Remember!**  
  You can always reset listers to their default schema. |
| 13.  | ![Image](image4.png) |  
  - Check to confirm that your TE Client will display the Demographics lister in ‘your’ default Schema next time you open it.  
  - To close the **Demographics** lister,  
  o Click the **Red X Box** on the **Demographics** tab. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 14.  | ![Screen Image](image1.png) | • You can also close several pages at the same time by clicking **Pages** at top right.  
• From the drop-down menu,  
  o Click **Close All Pages**.  
  o Or click individual **Pages** listed at bottom of the menu. |
| 15.  | ![Screen Image](image2.png) | • To reopen the **Demographics** lister, go to  
  ➢ Records > Students > Demographics  
• The list of **Demographics** records should display as the saved default **Schema** on your TE Client. |
| 16.  | ![Screen Image](image3.png) | **Note!**  
• You may also name different **Schemas** and access them from the **Toolbar** at top of the list  
  o Click the **(Default)** window down arrow and select a saved **Schema**. |
Using the Navigator

Let the TE Navigator be your guide! In listers, the Navigator links all ‘child’ records related to the ‘parent’ record and displays them in a list to navigate easily between them. The report setup Navigator gives quick access to listers to refine information to include in the report.

The Navigator will also guide you to adding ‘child’ records to ‘parent’ records by prepopulating key fields from the ‘parent’ record. When entering data manually, it is recommended to use the Navigator for data-entry accuracy.

Using the student as an example, let’s explore ‘child’ records and see how many are linked to the student’s ‘parent’ Demographic record through the Navigator.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Step 1 Screen](image1.png) | • Filter for a Student with your First or Last Name.  
  o Click the First or Last Name column Filter icon.  
  o Enter your First Name.  
  o Click OK. |
| 2.   | ![Step 2 Screen](image2.png) | • The Demographics lister may or may not display a record of a student having your First or Last Name. That’s Ok!  
  o Filter for a friend or any other name instead.  
  o Double click to open the Highlighted record. |
| 3.   | ![Step 3 Screen](image3.png) | • A new tabbed page opens to a split screen with the –  
  o Record Navigator at left.  
  o Student Information at right.  
  • Edit/View contains the ‘parent record’ data for the student.  
  • Remaining selections on the Navigator represent ‘child records.’ |
### Step 4.

#### Screen

![Navigator Screen](image1.png)

#### Description

- Clicking the different options from the **Navigator** provides views of a variety of information about that student.

**Remember!**

- The student’s unique **Identification (ID)** code is what links all of the records assigned to the student, and supplies the minimum information TE needs to create a student Demographic record.

### Step 5.

#### Screen

![Navigator Screen](image2.png)

#### Description

- From the **Navigator** at left,
  - Click **In Program Years**.
- At right lists records for each program year in which the student has dated activity.
- A **Program Year** is defined as **July 1 through June 30**.

### Step 6.

#### Screen

![Navigator Screen](image3.png)

#### Description

- From the **Navigator** at left,
  - Click **Student Records**.
- The records listed at right are of all dated activity that occurred for the student during the program year.

### Step 7.

#### Screen

![Navigator Screen](image4.png)

#### Description

- From the **Navigator** at left,
  - Click **Class Enrollments**.
- This list will only include one record for each class in which the student is enrolled.
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8.   | ![Step 8 Screen](image1.png) | • From the **Navigator** at left,  
  o Click **Class Records**.  
  • This section includes separate records of all class related activity for the student. |
| 9.   | ![Step 9 Screen](image2.png) | • From the **Navigator** at left,  
  o Click **Program Enrollments**  
  • This section will only include one listing for each program in which the student is enrolled. |
| 10.  | ![Step 10 Screen](image3.png) | • From the **Navigator** at left,  
  o Click **Program Records**.  
  • This list includes separate records of all program related activity for the student. |
| 11.  | ![Step 11 Screen](image4.png) | • From the Navigator at left,  
  o Click Tests.  
  • This is a list of tests taken by the student. |
| 12.  | ![Step 12 Screen](image5.png) | • Return to **Edit/View** to edit Student Information. |
## Editing Information

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 13. | ![Screen 1](image1.png) | • By default, the Edit/View page opens in View mode.  
  • To edit a student ID,  
    - Click the Pencil icon in the Identification section and Change to Edit Mode. |

| 14. | ![Screen 2](image2.png) | • Type in the Student ID field and change the ID.  
• From the Toolbar at top.  
  - Click Save.  

  **Note!** A change to the Student ID will simultaneously edit all ‘child’ records linked to the student. |

| 15. | ![Screen 3](image3.png) | • To see how that works,  
  - Click Tests from the Navigator.  
• You may notice that the ID does not appear to have changed.  
• Continue on to solve the mystery!... |
### Step 16

<table>
<thead>
<tr>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image16.png" alt="Screen 16" /></td>
</tr>
</tbody>
</table>

- At top right of the student’s Tests lister,
  - Click Refresh.
- This will ‘refresh’ the page on your TE Client.

### Step 17

<table>
<thead>
<tr>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image17.png" alt="Screen 17" /></td>
</tr>
</tbody>
</table>

- **Voila!**
  - Now you see that the ID on all Tests linked to the student are changed.

### Step 18

<table>
<thead>
<tr>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image18.png" alt="Screen 18" /></td>
</tr>
</tbody>
</table>

- To clear your screen,
  - Click Pages at top right.
    - Select Close all Pages.
Adding Records

The CASAS Online System offers four methods for adding records to your online account through both applications – eTests Online together with TE Online.

- **eTests Online**
  1. **Sessions** – for testing and collecting demographic information
- **TE Online**
  2. **Manual data entry** – using the keyboard and mouse
  3. **Scanning** – using an optical mark scanner
  4. **Importing** – from a 3rd Party System or fillable Import Template

Steps to Add Sites

Sites are part of the organizational structure of an online account and represent physical locations where testing, instruction, and training take place. A site may serve learners in multiple instructional and training programs. Agencies may add Sites to their online account at any time.

**eTests Site**

Any Site using eTests Online must comply with all testing requirements in each lab within a Site as outlined in the Online Implementation Agreement training.

- Web-test units (WTUs) must be available in an online account to enable an eTests Site.
- Sites must be enabled for eTests to register computers and administer tests.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Organization Menu](image) | From the **Menu bar** at top,  
  - Click **Organization**.  
    - Select **Sites**. |
Table of Contents

19

Site Records

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>• A new tabbed page opens listing the <strong>Sites</strong> setup in the online account.</td>
</tr>
<tr>
<td></td>
<td>• Sites that use eTests Online are identified as an <strong>eTests Site</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To be an <strong>eTests Site</strong>, agencies complete a <strong>“Going Live” Checklist</strong> , which includes:</td>
</tr>
<tr>
<td></td>
<td>o Online Implementation Agreement</td>
</tr>
<tr>
<td></td>
<td>o Coordinator Certification</td>
</tr>
<tr>
<td></td>
<td>o Proctor Certification</td>
</tr>
<tr>
<td></td>
<td>o Order web-test units (WTUs)</td>
</tr>
<tr>
<td></td>
<td>• From the <strong>Toolbar</strong> at top left,</td>
</tr>
<tr>
<td></td>
<td>o Click <strong>New</strong>.</td>
</tr>
<tr>
<td>3.</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>• A new tabbed <strong>Page</strong> opens to add information about the new <strong>Site</strong> for your agency.</td>
</tr>
<tr>
<td></td>
<td>• Sites are added to <strong>Containers</strong>, which ‘contain’ records of activity occurring at that site.</td>
</tr>
<tr>
<td></td>
<td>o Your <strong>Agency</strong> is the ‘parent’ container for your online account.</td>
</tr>
<tr>
<td>4.</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Sites</strong> are ‘child’ records of your <strong>Agency</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Sites</strong> are typically added to the ‘parent’ container but may also be a Sub-Site.</td>
</tr>
<tr>
<td></td>
<td>• The determination of ‘where’ to add a new <strong>Site</strong> depends on How? you plan to track and record outcomes.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Container</strong> field down-arrow.</td>
</tr>
<tr>
<td></td>
<td>o Select the <strong>Container</strong> to add the new <strong>Site</strong>.</td>
</tr>
<tr>
<td>Step</td>
<td>Screen</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 5.   | ![Site Identification](image1) | • For **Site Identification**,  
  o Enter the **Site ID**.  
  o Enter the **Site Name**.  
  o Check **eTests Site** –  
  ▪ *Only check if you plan to use CASAS eTests Online at the Site and WTUs are available for online test administration.*  
  • From the **Toolbar** at top,  
  o Click **Save**. |
| 6.   | ![Site Information](image2) | • To close the new **Site** record,  
  o Click the **Red X Box** on the **Site** tab. |
| 7.   | ![Sites Lister](image3) | • This returns you to the **Sites** lister where you will see the new **Site** in the list of records. |
| 8.   | ![Sites Lister](image4) | • Click the **Red X Box** on the **Sites** tab and close the lister. |
Steps to Add and Manage Users

Access to the CASAS Online System requires a User record with login credentials. Users are part of the organizational structure of your online account. When setting up a new account, CASAS establishes one User for the agency with rights to manage data and grant User access to TE Online and/or eTests Online for other staff as appropriate. When adding Users to your online account, CASAS recommends adding records at the agency level for ease with managing records and user access.

Access to TE Online
- May be granted to any staff as appropriate.
- eTests Online coordinator and proctor certification is not required for staff access TE Online.

Access to eTests Online
- May only be granted upon confirmation of coordinator and/or proctor certification.
- The agency must maintain copies of certificates on file.
  - Coordinator Certification – Staff responsible for online testing management.
  - Proctor Certification – Staff responsible for online test administration.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   |        | • From the Menu bar,  
|      |        |   o Click Organization.  
|      |        |     ▪ Select Users. |
| 2.   |        | • A tabbed page opens to the list of User records.  
|      |        | • From the Toolbar at top left of the list.  
|      |        |   o Click New. |
### Step 3
**Screen:**
- **User Information**

**Description:**
- Check **Link with existing personnel** –
  - *When* a Personnel record exists in your online account.
  - *If a record does not exist*, you will have the option to link accounts when adding the Personnel record.

### Step 4
**Screen:**
- **Select Container**

**Description:**
- Click the **Container** field down-arrow.
  - *Select* the container to add the new User record.
  - **Note!** Add Users at the Agency level when linking accounts with Personnel records.

### Step 5
**Screen:**
- **User Information**

**Description:**
- **User Identification** will be the login credentials for the new User.
  - *Enter* a Work e-mail address as the user name (recommended).
  - *Enter* a temporary **Password**.
    - Users are prompted to change their password the first time they log in.

### Step 6
**Screen:**
- **Groups**

**Description:**
- Add the new User to an **Access Group**.
  - *You have* three options to do this.
- Click the **Group** field down-arrow,
  1. **Type to Search** for the Group.
  2. **Scroll to Select** the Group.
  3. **Select** [Group] from Lister.

### Step 7
**Screen:**
- **User Identification**

**Description:**
- After selecting an Access Group,
  - *Click Add* at right of the selected Group.
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8.   | ![Group Name Screen](image) | - If the new User will need access to eTests Online to:  
  - Manage online testing (Coordinator).  
  - Administer online tests (Proctor).  
    - Add the new user to the access group that matches with their certification. |
| 9.   | ![User Information Screen](image) | - Add Contact Information for the new User.  
  - The minimum information required for adding an account is:  
    - First Name.  
    - Last Name.  
    - Email |
| 10.  | ![ Toolbar Screen](image) | - No other setup is needed for the new User when added to Access Groups.  
  - From the Toolbar at top,  
    - Click Save. |
| 11.  | ![First/Last Name Screen](image) | - Click the Red X Box on the User record tab and return to the lister. |
| 12.  | ![First/Last Name Screen](image) | - Use the First/Last Name column filter to locate the new User among the list of records. |
Access Groups

Step Screen Description

13. • Click the Red X Box and close the Users lister.

Group Access Rights

For ease with managing Users through Access Groups, establish and maintain groups at the agency level (i.e., parent container).

Step Screen Description

1. • From the Menu bar,
  o Click Organization.
    ▪ Select Access Groups.

2. • The tabbed page opens listing Groups for Agencies to manage User Access to TE.
• TE Data Managers may –
  o Edit, Rename, or Duplicate the default set of groups added by CASAS when setting up a new online account.

3. • TE Data Managers may also –
  o Add new TE Access Groups to manage users based on their role at the Agency, such as a School Counselor or the Registrar.
### Access Groups

**Step** | **Screen** | **Description**
--- | --- | ---
4. | ![Image](406x780.png) | - Groups have access to TE according to the rights enabled in **three** areas:
  1. **Menu** Access Rights
     - Defines access to menus and submenus.
  2. **Container** Access Rights
     - Defines access to sites and sub-sites.
  3. **Data** Access Rights
     - Defines read-only access, or rights to create, update, and/or delete data.

5. | ![Image](406x780.png) | - Granting **Teachers** access to TE requires having a **User** record linked with a **Personnel** record to identify their **Functional Role** as the teacher for their classes.
  - Teachers may,
    - Generate **Reports** for their own classes.
    - Manage their **Class Enrollment**.
    - Record **Attendance**.
    - View **Test** results taken by students enrolled in their class.

---

**Ask CASAS!** To apply the default set of **Access Groups** to your online account

---

For more information about **Access Groups** is available from the training materials library on the CASAS website at [Home > Training and Support.](http://www.casas.org)
## Steps to Add Student Records

The recommended approach to adding and editing Student records is from the Demographics list of records. Using the Navigator to add or edit ‘child’ records will ensure data entry accuracy with prepopulated ‘parent’ information.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Screen 1](image1.png) | - From the **Menu bar**,  
  - Click **Records**.  
  - Select **Students**.  
  - Click **Demographics**. |
| 2.   | ![Screen 2](image2.png) | - From the **Toolbar** at top left of the **Demographics** page,  
  - Click **New**. |
| 3.   | ![Screen 3](image3.png) | - A new tabbed page opens to input **Student Information**.  
  - Select the **Site** where the student will have activity.  
  - Enter the minimum (recommended) **Identification**.  
  - Student ID.  
  - First/Last Name.  
  - Gender.  
  - Birth Date.  

**Note!** Use eTests Online to collect and ‘fill-in’ remaining **Demographics**, or add students in TE automatically.
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4.   | ![Screen Screenshot](image.png) | - Click Save from the Toolbar at top.  
- If adding no other record for the Student at this time, the new record will not display in the list of Demographic records automatically.  
  - This is because the Student has no activity in the current program year (i.e., no In Program Years record.)  
- Adding any record from the Navigator, such as results from a paper Test, will add the In Program Years record automatically.  
- Adding paper Test results also prepares the online system to give the student the next assigned test in eTests Online automatically. |
| 5.   | ![Step Screenshot](image.png) | - Continue with steps to add a Test record for the new student. |
Steps to Add Test Records

Use the Navigator from the student’s Demographics record to add a Test record. Again, this recommended approach will ensure data entry accuracy with prepopulated ‘parent’ information about the student.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Navigator](image) | • From the Navigator at left,  
  o Click Tests.  
• From the student’s Tests lister,  
  o Click New. |
| 2.   | ![Test Information](image) | • A new tabbed page opens to input Test information.  
  • The Test record prepopulates with Site, Program Year and Student fields automatically.  
  • Enter the Assessment Date.  
    o Use the drop-down calendar  
    o Or type the Date. |
| 3.   | ![Assessment Information](image) | • For Assessment Information,  
  o Click the Form field down-arrow, and select a Test Form.  
    ▪ Type to Search.  
    ▪ Scroll to Select.  
    ▪ Select from Lister.  
  Scoring Option #1  
  • Check Score Override.  
    o Enter the Raw Score.  
  • Scale Score auto-populates after saving the record. |
### Table of Contents

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen Description</th>
</tr>
</thead>
</table>
| 4.   | Scoring Option #2 • You also have the option of entering item responses if you plan to generate performance reports from test results.  
• Leave **Score Override** unchecked  
• Enter **Responses** to each test item.  
• **Raw** and **Score Scale** auto-populate after saving the record.  
• Click **Save** from the **Toolbar** at top. |
| 5.   | • Click the **Red X Box** on the **Test** record tab and return to the student’s **Demographics** record. |
| 6.   | • You will now see the new record in the student’s **Tests** lister.  
• Click **Refresh** in the Tests lister **Toolbar** if needed to display Tests. |
| 7.   | • Click the **Red X Box** on the **Student** record tab and return to the Demographics lister.  
• Click the **Filter icon** in the **Student ID** column.  
• Enter the **Student ID**.  
• Click **OK**. |
| 8.   | • The new **Student** record is now in the **Demographics** list of records for the current program year. |

**ACTIVITY:** Sign back on as your fictitious Teacher to Enroll the Student in your Class and see the student’s Test record. Note: Student record must be at the Class Site to enroll and see Tests taken at any site.
Class Definitions

Steps to Add Class Records

Overview

- The CASAS Online System offers two methods for adding Class Records to your online account with –
  - TOPSpro Enterprise (TE) through –
    1. Manual data entry, or
    2. Import from a 3rd – Party System or fillable Import Template.
- Adding Classes in the CASAS Online System is a two-part process.
  1. Class Definition – defines classes as they occur across time.
  2. Class Instance – adds instances of classes occurring within a program year (i.e., July 1 – June 30).

Class Definitions

- The first record to add for the new Class is the Class Definition record.
- The Class Definition record defines what class occurs across time.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Organization Menu](image) | - **Classes** are manually added –  
  - From the Organization menu, and  
  - Selecting Classes.  
- Each Class set-up in your online account has  
  - One Definition record, and  
  - An Instance record per program year. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2.   | ![Screen](image1.png) | • To add a new **Class**,  
  o Click **Definitions**. |
| 3.   | ![Screen](image2.png) | • A list opens to display **Class Definition** records in your online account.  
  • By default, the list is sorted by **Class ID**.  
  • To add a new **Class Definition** record,  
    o From the **Toolbar** at top left of the list,  
      ▪ Click New. |
| 4.   | ![Screen](image3.png) | • A new tab opens to input **Class Definition Information** in two distinct sections.  
  1. Selecting the **Site**, and  
  2. Entering **Class Definition** information. |
| 5.   | ![Screen](image4.png) | • **All Classes** are set-up at **Sites**.  
  • To select a **Site**,  
    o Click the down-arrow in the **Site field**, and  
    o Select a **Site** from the drop-down menu. |
## Class Definitions

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 6.   | ![Select Site](image) | • The **Class ID** is assigned by the agency to uniquely identify a **Class** at a site.  
• Enter a unique **Class ID**.  

*Note!* This is a mandatory field and should match with a 3rd **Party System** if you plan to exchange data between systems, such as importing **Class Enrollments** or **Attendance Hours**. |
| 7.   | ![Select Site](image) | • Use an optional **Extended ID** to make multiple instances of the class from a common **Class Definition**.  
• For example, if the **Class** occurs each semester per year,  
  o **Extended ID**: FALL allows you to use the same **Class ID** in Fall of the current program year and in Fall of each program year thereafter. |
| 8.   | ![Select Site](image) | • **Course Code** is optional.  
• A course code records class content according to local or statewide definitions.  
• If entered, the course code appears in reports with the **Class ID**. |
| 9.   | ![Select Site](image) | • To describe a **Class** offered at a particular **Site**,  
  o Enter the **Class Description** as identified at the agency or from a registration system.  
  o This is a mandatory field |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 10.  | ![Class Definition Information](image1.png) | - From the Toolbar at top of the New Class Definition Information record,  
  - Click Save. |
| 11.  | ![Class Definition Information](image2.png) | - The new Class Definition record screen splits to display the –  
  - Navigator at left to add and access “child”-related records for the Class, and  
  - Class Definition Information at the right. |
**Class Instances**

**Class Instance**

- The next record to add for the new **Class** is the **Class Instance**.
- The **Class Instance** record identifies when the class occurs during a program year.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Navigator at left of the Class Definition Information record](image1) | • From the **Navigator** at left of the **Class Definition Information** record,  
  o Click **Class Instances**.  
  • To add an **Instance** for the **Class**,  
  o Click **New** at right. |
| 2.   | ![New Class Instance](image2) | • A new tab opens to input **Class Instance Information** in three distinct sections.  
  1. **Class Definition**  
  2. **Class Instance**  
  3. **Intensity** |
| 3.   | ![Select Class Definition](image3) | **Recommended!** Site and **Class Definition** fields auto-populate saving time and ensuring accuracy with manual data entry. |
| 4.   | ![Select Program Year](image4) | • Using the **Navigator** is the recommended approach when adding records that are related.  
  • When using the **Navigator** to add a **Class Instance** from the **Class Definition** record,  
  • To select the **Program Year**,  
  o Click the **down-arrow** and  
  o Select the **Current Program Year** from the drop-down menu. |
### Table of Contents

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 5.   | ![Class Instance Screen](image1) | • The next section provides details about the Class Instance.  
• For Class Start and End Date, click the drop-down calendar.  
  o Select the Start Date.  
  o Select the End Date. |
| 6.   | ![Instructional Program Screen](image2) | • Check the Instructional Program that best describes the class offering. |
| 7.   | ![Special Program Screen](image3) | • Check a Special Program to further define the class offering if applicable, such as –  
  o Distance Learning. |
| 8.   | ![Transition Focus Screen](image4) | • A Transition class has a specific purpose to prepare students for entry into postsecondary education, training, or an apprenticeship program.  
• Check a Transition Focus that applies to the class. |
| 9.   | ![Focus Area Screen](image5) | • If applicable,  
  o Select the English Literacy Focus Area from the drop-down menu for the class otherwise,  
    ▪ Leave N/A selected. |
| 10.  | ![Class Notes Screen](image6) | • Enter Class Notes to provide additional details about the class.  
• If applicable, enter the California Basic Educational Data System code. |
| 11.  | ![Instructional Setting Screen](image7) | • Instructional Setting is the contextual characteristic of the setting where actual instruction takes place.  
• Select the Instructional Setting that applies to the class, such as –  
  o Classroom plus Distance Learning. |

**Note:** CBEDS Codes reflect instructional practices and CA state curriculum guidelines.
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 12.  | ![Physical Setting](Image) | • **Physical Setting** identifies the environment of the classroom, or instructional setting, to support teaching, or learning.  
• Select the **Physical Setting** that applies to the class. |
| 13.  | ![Start Time](Image) | • Identify the time of day when the class starts. |
| 14.  | ![Computers used in class](Image) | • Specify if **Computers are used in class** or in a lab and whether or not computers are connected to the Internet. |
| 15.  | ![Intensity](Image) | • For **Intensity**, enter the number of  
  o Days per Week when the class meets,  
  o Total Hours per week, and  
  o Estimated Total Hours per Class or Term |
| 16.  | ![Class Instance](Image) | • To save detailed information about the **Class Instance**,  
  o From the **Toolbar** at top of the record,  
    ▪ **Click Save.** |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.</td>
<td><img src="image1.png" alt="Image" /></td>
<td>• Click the Red X Box on the Class Instance tab to close the new record and return to the Class Definition record.</td>
</tr>
<tr>
<td>18.</td>
<td><img src="image2.png" alt="Image" /></td>
<td>• The new Class Instance record is now listed at right of the Navigator in the Class Definition Information record.</td>
</tr>
</tbody>
</table>
| 19.  | ![Image](image3.png) | • A Class Definition and Instance for the same class occurring in the Spring may be added at the same time.  
  • From the Navigator at left,  
    o Click Edit/View and then  
  • From the Toolbar at top,  
    o Click Duplicate. |
| 20.  | ![Image](image4.png) | • In the new Class Definition Information record,  
  o Change FALL to SPRING, and then  
  o From the Toolbar at top,  
    ▪ Click Save. |
<p>| 21.  | <img src="image5.png" alt="Image" /> | • Click the Red X Box on the Class Definition tab to close the new record and return to the Class Definitions Lister. |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 22. | ![Image](image1.png) | • To add an **Instance** of the **Fall** class in the **Spring**.  
  o Double-click to open the **Fall Class Definition** record. |
| 23. | ![Image](image2.png) | • From the **Navigator** at left of the **Fall Class Definition** record,  
  o Click **Class Instances**.  
  o From **Class Instances** list at right,  
  ▪ Double-click to open the **Fall Class Instance** record. |
| 24. | ![Image](image3.png) | • From the **Toolbar** at top of the **Fall Class Instance** record,  
  o Click **Duplicate**. |
| 25. | ![Image](image4.png) | • In the new **Class Instance Information** record,  
  o Use the drop-down menu and  
  ▪ Select the **Spring Class Definition** record, and then  
  o Change **Class Start** and **End Date**.  
  • From the **Toolbar** at top,  
  o Click **Save**. |
26. • Click the Red X Box on the Class Instance tab to close the new record and return to the Class Definition record.

27. • Click the Red X Box on the tab to close the Class Definition record and return to the Class Definitions Lister.
• Click Refresh to display both ABE – Multi-Level classes for
  o FALL and
  o SPRING semesters.

28. • To view related records, at far right in the Toolbar,
  o Click More, and then from more buttons available,
    ▪ Click Child Lister.

29. • From the Child Lister Navigator at left,
  o Click Class Instances.
• With the ABE – Multi-Level FALL Class Definition record highlighted in the top page,
  o The Class Instance record will automatically display in the Child Lister page at the bottom.
• From the Class Definitions page at the top,
  o Click to highlight the ABE – Multi-Level SPRING Class Definition record.
    ▪ The Class Instance record for the Spring now displays in the Child Lister page at the bottom.
### Import Class Data

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Screen](image) | - See [TOPSpro Enterprise Data Exchange Specifications](#) for more information about importing Class Data.  
  - IMPORT: CLS – Class Data  
  - A folder of [TE Data Import Templates](#) is available from the CASAS website to help you populate your online account without manual data-entry or 3rd Party System.  
    - Go to: Home > Product Overviews > Software > TOPSpro Enterprise > TOPSpro Enterprise Help > Data Exchange > TE Data Import Templates  
  
  **Note!** Before importing Class Data, import Personnel Data first to assign teachers to classes – i.e., automatically add Functional Roles.  
  - IMPORT: PERS - Personnel and User Data |
### Steps to Add and Link Personnel Records

Personnel records are part of the organizational structure of an online account and include Registration, Functional Role, Employment Record, and Professional Status information.

#### Personnel Registration

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Menu Bar Select Personnel](image1.png) | - From the **Menu bar**.  
  - Select **Personnel**.  
    - Click **Registration**. |
| 2.   | ![Organization Records Select Registration](image2.png) | - To add a new **Personnel** record,  
  - Click **Registration**. |
| 3.   | ![Toolbar New](image3.png) | - A tabbed page opens to the list of **Personnel** records in your online account.  
  - From the **Toolbar** at top left of the list,  
    - Click **New**. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen Description</th>
</tr>
</thead>
</table>
| 4.   | ![Personnel Information](image1)  

- When a User record exists in your online account,
  - Check **Link with existing user**.  

| 5.   | ![Personnel Information](image2)  

- Click the **Container** field down-arrow.  
  - Select the **Agency** level (recommended)  
  - Or **Site** level.  

| 6.   | ![Personnel Information](image3)  

- You have **three** options to select an existing User.  
- Click the **User** field down-arrow,  
  1. **Type to Search** for the User.  
  2. **Scroll to Select** the User.  
  3. **Select [User] from Lister**.  

| 7.   | ![Personnel Information](image4)  

- When the User is located,  
  - Click on the **User** to select.  

---

© 2020 CASAS – Comprehensive Adult Student Assessment Systems. All rights reserved.
### Step Screen Description

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8.   | ![Personnel Information](image1.png) | - **Personnel Information** fields auto-populate after selecting and linking the User.  
  - Enter an Agency **Personnel ID**. |
| 9.   | ![Toolbar](image2.png) | - From the **Toolbar** at top,  
  - Click **Save**. |
| 10.  | ![Registration Tab](image3.png) | - The new **Personnel** record page splits automatically with  
  - **Personnel Information** at right  
  - **Navigator** at left to add and access Personnel records.  
  - Click the **Red X Box** on the **Registration** tab and return to the Personnel record. |

### Functional Roles

Functional Roles identify personnel involved in the administration and teaching of adult learners. Personnel may have more than one Functional Role within the agency. Adding Functional Roles for teachers gives them access to their classes at any time from any location with Internet connection.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Navigator](image4.png) | - From **Navigator** at left of the **Personnel Information** record,  
  - Click **Functional Roles**.  
  - To add a **Functional Role** for the Personnel member,  
  - Click **New** at right. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2.   | ![Image](image1.png) | • A new tab opens to input **Functional Role Information** in **three** sections.  
  1. **Personnel information**,  
  2. **Container** to associate the role.  
  3. **Role Identification**.  
  • **Personnel** and **Container** fields auto-populate when using the **Navigator** to add records.  |
| 3.   | ![Image](image2.png) | • To link the **Personnel** member with a **Class**,  
  o Click the **Class Definition** field down-arrow and  
    ▪ **Type to search**.  
    ▪ **Scroll** to select.  
    ▪ **Select from Lister**  
  o **Select** the **Class**.  |
| 4.   | ![Image](image3.png) | • If the **Personnel** member is *not* a teacher,  
  o Leave “**No selection**” in the **Class Definition** field.  
  • **Special Program** will auto-populate if defined for the selected class.  |
| 5.   | ![Image](image4.png) | • For **Role Identification**,  
  o Select **Administrator**, **Scorer**, or **Teacher**.  
  o Select the **Start Date** when the role begins.  
  o Leave **End Date** empty if the role will continue across program years.  |
### Step 6
- From the Toolbar at top,
  - Click **Save**.

### Step 7
- Return to the **Personnel** record.
  - Click the **Red X Box** on the **Functional Role** tab and return to the **Personnel** record.

### Step 8
- The **Functional Role** record is now listed with the **Personnel** record.

**Note!** Personnel may have more than one **Functional Role** at the agency.

### Employment Records
The next record to add for **Personnel** is information about their employment. **Personnel** may have more than one **Employment Record** to identify different types of employment within the agency.

### Professional Status
The last record to add for **Personnel** is information about their professional status.

Detailed steps for adding **Personnel Employment** and **Professional Status** records are available from the training materials library on the CASAS website at [Home > Training and Support](#).
**ACTIVITY: Access the New Teacher’s Class**

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Image](image1.png) | - At top left of your screen,  
    o Click the TE icon.  
    o Click Disconnect. |
| 2.   | ![Image](image2.png) | - Log in as the Teacher.  
    o Enter Credentials.  
    o Click Connect. |
| 3.   | ![Image](image3.png) | - From the Menu Bar at top,  
    o Click Organization.  
    o Click Classes.  
    o Click Instances. |
| 4.   | ![Image](image4.png) | - The teacher’s Class will display in the list.  
    - Double-click on the Class to open the record. |
| 5.   | ![Image](image5.png) | - With access to Classes, teachers can –  
    o Record Attendance.  
    o Enroll students and update their Status in class.  
    o View Tests taken by students enrolled in the class.  
    o Generate Student & Class Reports. |
| 6.   |   | - **Note!** For training, you will need to Disconnect from TE and then Connect again with your Admin account to proceed with the next steps. |
Scanning Data

Scanning is a commonly used method for entering data into TOPSpro Enterprise (TE) Online using an optical mark reader (OMR), or scanner. For a list of OMR compatible scanners, visit the CASAS website at Home > Product Overviews > Software > TOPSpro Enterprise.

There are eight answer sheets for use with TE. These answer sheets provide agencies with options for gathering demographic, testing, program, and accountability information. Answer sheets also simplify the process of capturing new data required by many federal reporting requirements. A list of answer sheets used with the type of data you plan to bring in to TE can be found on the CASAS website at: Home > Product Overviews > Software > TOPSpro Enterprise > Answer Sheets and Test Records.

A set of simulated scanning files is available from the CASAS website at: Home > TOPSpro Enterprise Help > TE Hands on Training > SimScan Files to learning the features of scanning in a “controlled” environment. This will ensure that you follow the same steps and learn these concepts as they relate to TE without concern for any specific features of your own agency’s scanner.

Prepare Records for Scanning

Before bringing any new data into TE through scanning, it is recommended that you prepare the answer sheets and test records to minimize errors when scanning.

Students are given specific directions for marking answers.

Directions for marking answers
- Use No. 2 pencil only
- Do NOT use ink or ballpoint pen
- Make dark marks that fill oval completely
- Erase cleanly any answers you change

To prepare for scanning, visually inspect answer sheets and test records for quality of marks. This will ensure that all bubbled information reads correct when scanned.

- Fill in marks that do not fill the oval completely.
- Darken marks that may be too light for the scanner to read properly.
- Erase errant marks and answers that were not erased cleanly.

Take note of ID and Date fields for accuracy.
• Knowing the format of an ID assigned to your students, make sure entries in the **Student Identification** field match with that format.

• The **Date of Birth** field requires leading zeros for month and day, if single digits.

• The **Highest Year of School** field also requires a leading zero if the number of years is a single digit.

• Use scanning overrides for **Class ID**, **Program Entry Date**, test **Form Number** and **Test Date** when possible (recommended).

Even though you may be diligent with preparing forms to scan, you will have the opportunity to edit any scanned information due to scanning errors prior to importing the data.
**Steps to Scan Records**

The Scanning Wizard will step you through the process for importing records through the scanning process. The process is essentially the same for each type of record however; it is important to take note of subtle differences for how you allow specific imports to populate your online account.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 17.  | ![Scanning Wizard](image1) | • From the **Menu bar** at top,  
  o Click **Tools**.  
  o Click **Scanning Wizard**. |
| 18.  | ![Scanning Wizard](image2) | • The **Scanning Wizard** opens with two choices for how you want to proceed.  
  1. Run a **New scanning session**.  
  2. Return to a **previous scanning session** to continue with data correction or with the import operation of the scanned records. |
| 19.  | ![Scanner Settings](image3) | **Note!** For scanner installation, refer to the instructions that came with the scanner. You may also contact Scantron or CASAS Tech Support for assistance.  
• On the **Scanner Settings** window, it is necessary to ensure scanner settings are correct for the type of **Scanner** your program uses before scanning any new data into TE.  
• **Scanner Settings** will change depending on the **Scanner Type** selected.  
• To begin the scanning process,  
  o Click **Next**. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20.  | ![Simulate Scanning](image) | **Note!** For training purposes,  
  - Select **Simulate Scanning**.  
  - This disables **Hardware Control** settings so that TE looks for a scanning file instead of an actual scanner.  
  - Use this setting when training on the **Simulation Server** using **SimScan Files**.  
    - Click Next. |
| 21.  | ![Answer Sheet Selection](image) | - On the **Answer Sheet Selection** window,  
    - Identify the **type of record(s)** you are scanning.  
    1. For **single-sided** OMR scanners,  
      - Select a **Front Side** option only.  
    2. For **dual-sided** OMR scanners,  
      - Select **Front Side** and **Back Side** options.  
    - Click Next. |
| 22.  | ![Simulated Scanning](image) | **Note!** For simulated scanning,  
  - Use **Front Side** for training with **SimScan Files**.  
    - Select **Entry**, **Update**, or **Test**.  
  - Leave selection to **None** for **Back Side**. |
### Scanning

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 23. | ![Screen](image1) | • The **Scanning Wizard** is ready to scan.  
  1. Click **Scan**.  
  • When all records are scanned,  
  2. Click **Stop**. |
| 24. | ![Screen](image2) | • The selected **SimScan File** will load quickly!  
  o Click **OK**.  
  **Note!** For simulated scanning,  
  o Click **Scan**.  
  • Locate **SimScan Files** on the local machine.  
    o Select **Entry**, **Test**, or **Update**.  
    o This initiates the “scanning” part of simulated scanning.  
  • Continue with **Override Scanning Options**. |
| 25. | ![Screen](image3) | • The total number of sheets scanned will display at top right of the **Scanning Wizard** window.  
  o Click **Next**.  
  • The **Scanning Wizard** is ready to scan.  
  • When all records are scanned,  
  2. Click **Stop**. |
Steps to Override Scanning Options

Override Scanning is a highly valuable feature in TE. Taking full advantage of this feature can save time by automatically entering an ‘override’ value that will replace information for that particular data field. Override options will differ depending on the type of form you are scanning.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Screen](image1.png) | - After records are scanned,  
- Use data field **Overrides** to apply to all records in the scanned batch.  
- Use data field **Defaults** to apply only when a data field is empty.  
**Note!** For simulated scanning, keep **Select field overrides** selected.  
  o Click Next. |
| 2.   | ![Screen](image2.png) | - From the **Front Overrides** window,  
  o Use drop-down arrows next to each field to choose an **Override** value option.  
  - A second window for **Back Overrides** will display with dual-sided scanning.  
  - After applying **Override** values,  
  o Click Next. |
| 3.   | ![Screen](image3.png) | - The **Scanning Wizard** is ready to process the raw data.  
  **IMPORTANT!** Pay close attention to information about the options and default settings on this window before you proceed, as they will vary based on the type of record you are scanning.  
  - Click Next. |
Steps to Edit Scanned Data

After you complete simulated or regular scanning, the Scanning Wizard preview window appears. It is recommended that you always preview what you scanned before accepting it into your database. You may also want to review your scanning information from a paper copy.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Scanning Wizard Window](image) | • The **Scanning Wizard** window opens with the list of scanned records.  
• The **Data Grid** at left of the list provides directions for editing records, if needed.  
  - **Yellow** records are cautionary.  
  - **Red** records are invalid.  
• Click on a **color record** to display an advisory message about the record at bottom of the list.  
• With the color record highlighted,  
  - Click **Edit Records**.  
  - Or double-click to open the **Data Correction Grid**.  

  **Note!** You have the option to **Save scanning session** to continue later with data correction. |
| 2.   | ![Selecting Records](image) | • **To edit multiple records**, first select them with Ctrl + click and / or Shift + click.  
• **To select all records**, click first on any row, then press Ctrl + a.  
• After selecting records, click **Edit Records**. |
| 3.   | ![Data Correction Edit Window](image) | • The **Data Correction Edit Window** opens to,  
  - Edit individual records.  
  - Apply a global override to all records.  
  - Correct invalid records.  
• Check fields to change and then select their new values.  
• You may need to scroll down the grid to see all data fields.  

  **Note!** Data fields will vary based on the type of records you are scanning. |
### Scanning

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4.   | ![Image](image1.png) | - After editing all fields as needed or necessary for the appropriate action,  
  - Click **Save** at bottom of the grid. |
| 5.   | ![Image](image2.png) | - When returned to the **Edit Records** window,  
  - The list of records should be clear of any color records to indicate that all records are ‘cleared’ for importing into the database.  
  - When you are ready to import the records,  
  - Click **Next**. |
| 6.   | ![Image](image3.png) | **Additional Button Options:**  
  - **Remove Records** – eliminates a record from being imported.  
  - **Cancel** – ends the import session without importing records.  
  - **Save scanning session** – creates a file of the scan session so that you can continue later with data correction.  
  - **Create Data Report** – will save a PDF report showing a breakdown of the records in the scan session.  
  - **Load Existing Data** – will auto-populate existing student information.  
  - **Back** – will take you to each previous window. |
|      |        | **Continue with ** **Importing Scanned Records** |
### Steps to Import Scanned Records

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td><img src="image1.png" alt="Screen" /></td>
</tr>
<tr>
<td></td>
<td><strong>Note!</strong> You may save [the] scanning session and continue later with the import operation of the scanned records.</td>
</tr>
<tr>
<td></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>• The <strong>Ready to import</strong> window indicates the number of <strong>Valid</strong> records the wizard will attempt to import.</td>
</tr>
<tr>
<td></td>
<td>○ Click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note!</strong></td>
</tr>
<tr>
<td></td>
<td>• Even though a record is considered <strong>Valid</strong> according to your TE Client, it may conflict with a record at the CASAS server.</td>
</tr>
<tr>
<td></td>
<td>• If this occurs, the system will inform you about the number of records that could not be imported.</td>
</tr>
<tr>
<td></td>
<td>• You will also have the option to correct data that could not import.</td>
</tr>
<tr>
<td>2.</td>
<td><img src="image2.png" alt="Screen" /></td>
</tr>
<tr>
<td></td>
<td>• The time to import records varies depending on the type of record and number of records being imported.</td>
</tr>
<tr>
<td></td>
<td>• You will have another opportunity to save [the] Import Session and return later to finish.</td>
</tr>
<tr>
<td></td>
<td>• You may also cancel importing records. Depending on when you cancel, records may have already imported.</td>
</tr>
<tr>
<td>3.</td>
<td><img src="image3.png" alt="Screen" /></td>
</tr>
<tr>
<td></td>
<td>• The Scanning Wizard ends with a scanning results window indicating the number of records that imported or did not import successfully.</td>
</tr>
<tr>
<td></td>
<td>• You have the option to save [the] scanning session so that you can continue later with data correction or with the import operation of the scanned records.</td>
</tr>
<tr>
<td></td>
<td>• To end the scanning session,</td>
</tr>
<tr>
<td></td>
<td>○ Click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>
Quick References to Locating Scanned Information in TE

For detailed descriptions of each field, click [WIOA Data Dictionary](#).

### SCANNED ENTRY INFORMATION

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>TE Menu Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. a.</td>
<td>Student Name (non-scanned data)</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>1. b.</td>
<td>Student Address (non-scanned data)</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>1. c.</td>
<td>Email Address</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>2.</td>
<td>Instructor Name (non-scanned data)</td>
<td>Organization -&gt; Personnel -&gt; Functional Roles</td>
</tr>
<tr>
<td>3.</td>
<td>Student Identification</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>4.</td>
<td>Gender</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>5.</td>
<td>Date of Birth</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>6.</td>
<td>Highest Year of School Completed</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>7.</td>
<td>Highest Diploma or Degree Earned</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>8. a.</td>
<td>Ethnicity</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>8. b.</td>
<td>Race</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>9.</td>
<td>Native Language</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>10.</td>
<td>Date of Entry into this Program</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>11.</td>
<td>Instructional Program</td>
<td>Records -&gt; Programs -&gt; Enrollments</td>
</tr>
<tr>
<td>12.</td>
<td>Attainable Goal Within Program Year</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>13.</td>
<td>Special Programs</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>14.</td>
<td>Employment Barriers</td>
<td>Records -&gt; Students -&gt; In Program years</td>
</tr>
<tr>
<td>15.</td>
<td>Class Number</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>16.</td>
<td>Personal Status</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>17.</td>
<td>Labor Force Status</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>18.</td>
<td>Instructional Level</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>19.</td>
<td>Provider Use</td>
<td>Records -&gt; Classes -&gt; Records</td>
</tr>
</tbody>
</table>
## Scanned Test Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>TE Menu Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Student Name (non-scanned data)</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>2.</td>
<td>Instructor Name (non-scanned data)</td>
<td>Organization -&gt; Personnel -&gt; Functional Roles</td>
</tr>
<tr>
<td>3.</td>
<td>Student Identification</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td>4.</td>
<td>Form Number</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td>5.</td>
<td>Test Date</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td>6.</td>
<td>Class Number</td>
<td>Records -&gt; Classes -&gt; Records</td>
</tr>
<tr>
<td>7.</td>
<td>Instructional Program</td>
<td>Records -&gt; Programs -&gt; Enrollments</td>
</tr>
<tr>
<td>8.</td>
<td>Hours of Instruction</td>
<td>Records -&gt; Classes -&gt; Records</td>
</tr>
<tr>
<td>9.</td>
<td>Raw Score</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td>10.</td>
<td>Test 1</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td>11.</td>
<td>Test 2</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td>12.</td>
<td>Test 3</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td>13.</td>
<td>Test 4</td>
<td>Records -&gt; Tests</td>
</tr>
<tr>
<td></td>
<td>Student does not yet have the skills to be tested.</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
</tbody>
</table>

For detailed descriptions of each field, click [WIOA Data Dictionary](#).
For detailed descriptions of each field, click [WIOA Data Dictionary](#).

### SCANNED UPDATE INFORMATION

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>TE Menu Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>d. Student Name (non-scanned data)</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>1.</td>
<td>e. Student Address (non-scanned data)</td>
<td>Records -&gt; Students -&gt; Demographics</td>
</tr>
<tr>
<td>2.</td>
<td>Instructor Name (non-scanned data)</td>
<td>Organization -&gt; Personnel -&gt; Functional Roles</td>
</tr>
<tr>
<td>3.</td>
<td>Student Identification</td>
<td>Records -&gt; Classes -&gt; Records</td>
</tr>
<tr>
<td>4.</td>
<td>Date of Program Update</td>
<td>Records -&gt; Classes -&gt; Records</td>
</tr>
<tr>
<td>5.</td>
<td>Instructional Program</td>
<td>Records -&gt; Programs -&gt; Enrollments</td>
</tr>
<tr>
<td>6.</td>
<td>Program Status</td>
<td>Records -&gt; Programs -&gt; Enrollments</td>
</tr>
<tr>
<td>7.</td>
<td>Program Progress</td>
<td>Records -&gt; Programs -&gt; Records</td>
</tr>
<tr>
<td>8.</td>
<td>Services Received</td>
<td>Records -&gt; Programs -&gt; Records</td>
</tr>
<tr>
<td>9.</td>
<td>Learner Results – Work</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>9.</td>
<td>Learner Results – Education</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>9.</td>
<td>Learner Results – Family / Community</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>10.</td>
<td>Class Number</td>
<td>Records -&gt; Classes -&gt; Records</td>
</tr>
<tr>
<td>11.</td>
<td>Hours of Instruction</td>
<td>Records -&gt; Classes -&gt; Records</td>
</tr>
<tr>
<td>12.</td>
<td>Post Exit Leading to Postsecondary Credential</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>13.</td>
<td>Instructional Level</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>14.</td>
<td>Leading to Postsecondary Credential or Enrollment</td>
<td>Records -&gt; Students -&gt; Records</td>
</tr>
<tr>
<td>15.</td>
<td>Reason For Exiting</td>
<td>Records -&gt; Programs -&gt; Enrollments</td>
</tr>
</tbody>
</table>
Tracking Results

Pre- and post-test pairs must always be from the same test modality.

Testing Guidelines

Pretests

Administer pretests as soon as feasible upon entry into the program and before the occurrence of any substantial instructional intervention.

All students with 12 or more hours of instruction must be pretested to include in the Federal Tables.

Students should be assessed in the areas that are the focus of instruction, using the appropriate CASAS standardized test in reading, math, listening comprehension, or writing.

- Required skill areas for ABE/ASE are reading and math.
- Required skill areas for ESL/ELL are reading and listening.

Post-tests

Administer post-tests using the next-assigned test forms.

- At the end of a semester, term, quarter, or other substantial block of instruction to document learning gains.
- Post-test scores obtained at the end of a semester or other reporting period may serve as a pretest for the next semester or reporting period, if the interim does not exceed four months for continuing students.

Multiple Modalities Paired Tests

What if a student has two sets of pretest and post-test scores, such as one in reading and one in listening?

- The pretest and post-test pair with the lowest accurate pretest score determines benchmark attainment.
- This satisfies the Federal requirement to address the student’s ‘highest area of need.’

What if the student has two pairs of tests, but one pretest/post-test pair is in an ESL class and the other pair is in ABE?
• This is the one exception to what is stated above.
• If a student has tests in multiple programs, then TOPSpro Enterprise follows an established hierarchy, which is:
  1. ESL/ELL – English as a Second Language/English Language Learner
  2. ABE – Adult Basic Education
  3. ASE – Adult Secondary Education
• So in the example above, TE would select the tests that are assigned to ESL.

Test Scores Outside Accurate Range

Scores Below the Accurate Range ( *)

If a student scores below the accurate range on a pretest,
• Do not delete the test from the database. Retain the record for historical data tracking / auditing and for determining the next appropriate / assigned test (NAT).
• Retest the student with a test from the next lower level for accurate placement. CASAS eTests Online will present the NAT automatically.

If a student scores below the accurate range on a progress / post-test,
• Do not delete the test from the database. Retain the record for historical data tracking / auditing and for determining the next appropriate / assigned test (NAT).
• Retest the student with a test from the next lower level. CASAS eTests Online will present the NAT automatically.

Conservative Estimate Scores ( ●)

If a student receives a conservative estimate score, which is above the accurate range, on a pretest,
• Retest the student with a test from the next higher level within one week of the initial pretest.
• The new assessment score replaces the conservative estimate score.
• Mark the replaced test as ‘Retested’ in the database to exclude results from reports and to retain the record for historical data tracking / auditing.

If a student receives a conservative estimate score on an appropriate level progress / post-test,
• The student has sufficiently demonstrated skill gain during that period of instruction and retesting is not needed at that time.
• Do not mark the progress / post-test as ‘Retested’ in the database.
• At beginning of the next scheduled period of instruction, retest the student with a test from the next higher level. CASAS eTests Online will present the NAT automatically.
Customizing the Tests Lister

Sometimes the obvious is the best place to start tracking results! The Tests Lister displays all current tests in your account. This is the ‘go-to’ Lister for monitoring the validity of test results. The default schema in the Tests Lister includes columns for test scores below accurate range and conservative estimate scores. Customizing this Lister further will help to detect test-taker behavior for tests administered with eTests Online such as:

- How much time did the student spend on the test?
- Was the student speeding through the test?
- Did the student finish the test within ‘normal’ test time?
- Did the student run out of time and the test ‘timed out’?

Follow these steps to customize the Tests Lister to help identify suspicious test results worth investigating.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Screen](image1.png) | From the Menu bar at top,  
  - Click Tests. |
|      | ![Screen](image2.png) | The Tests lister default schema:  
  - Sorts on most current Assessment Date.  
  - Includes columns for:  
    - Form  
    - Scale Score  
    - Accurate (scores)  
    - Conservative Estimate (scores) |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3.   | ![Filter Accurate](image) | • To filter for scores below **Accurate** range,  
  o Click the filter icon in the **Accurate** column.  
• From the drop-down menu,  
  o Check **No**.  
  o Click **Ok**. |
| 4.   | ![Scores Below Accurate](image) | • Scores below **Accurate** range are invalid.  
  o Retesting is required for both pre- and post-tests.  
• Invalid scores are not reportable.  
• The test record should not be deleted from the database in order to retain historical data for tracking and accountability. |
| 5.   | ![Check Red X Box](image) | • Check the **Red X Box** on the **Accurate** column filter.  
• This removes the column filter and returns the **Tests** lister to its last configuration. |
| 6.   | ![Filter Conservative Estimate](image) | • To filter for **Conservative Estimate** scores,  
  o Click the filter icon in the **Conservative Estimate** column.  
• From the drop-down menu,  
  o Check **Yes**.  
  o Click **Ok**. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 7.   | ![Image](image1.png) | • **Conservative Estimate** scores are valid and reportable.  
  ○ Retesting is required for pretests.  
  ○ Check with your State Assessment Policy for further guidance if/when retesting is required for post-tests. |
| 8.   | ![Image](image2.png) | • Add the **Retested** column to identify Tests excluded from reports and 3rd Party Exports.  
  ○ Right mouse-click in the column header.  
  • From the drop-down menu of additional columns,  
  ○ Click **Show Retested** to produce a list of potential retakes. |
| 9.   | ![Image](image3.png) | • Click the filter icon in the **Retested** column.  
  • From the drop-down menu,  
  ○ Check Yes.  
  ○ Click Ok. |
| 10.  | ![Image](image4.png) | • If students **Retested**, those test records would appear in the list.  
  • If no tests appear, that’s worth investigating!  
  • Check the **Red X Box** to remove both filters and move on… |
## Tracking Results

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 11.  | ![Image](Image1) | • Right-mouse click in the **Retested** column.  
  o Select **Hide Retested**. |
| 12.  | ![Image](Image2) | • Right-mouse click in the **Accurate** column header.  
  o Select **Show Assessment Duration in Minutes**. |
| 13.  | ![Image](Image3) | • The **Duration** column tells you the total number of **Minutes** the student spent taking the test.  
  • When students spend less time than appropriate for the test form level and modality, this is another area to address. |
| 14.  | ![Image](Image4) | • To gain additional insight about test-taker behavior while taking the test,  
  o Right-mouse click in the **Scale Score** column header.  
  o Select **Show Raw Score**.  
  • Take note of **Raw Score** results compared to the **Duration** minutes. |
### Step 15

<table>
<thead>
<tr>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
|        | - If *Duration* is low and *Raw score* is low,  
|        |   - There is a high probability the student clicked through the test rapidly.  
|        |   - Even though results may be *Accurate*, retesting should be considered.  
|        | - If *Duration* is low and *Raw score* is high,  
|        |   - That’s a good indicator the test was too easy for the student.  
|        |   - And if *Conservative Estimate* is ‘Yes’, that’s confirmation the student should be retested.  

### Step 16

- Another column to consider adding,  
  - *Show Terminate Test Reason*.  
- This will tell you more about the timing of the test.

### Step 17

*Remember!*
You can always reset listers to their default schema.

- If the additional columns and configuration of columns is something you want to save for when you reopen the *Tests Lister*, remember to save the schema!  
  - Click *More* from the *Toolbar* at top right for ‘more’ buttons.  
  - Click *Edit Schema*.  
- Save as ‘your’ *Default* schema on your TE Client, or enter a *Schema* name.  
  - Click *Save*.  

© 2020 CASAS – Comprehensive Adult Student Assessment Systems. All rights reserved.
The Report Generator

Whenever you select any report from the Reports menu, you are presented with the Report Setup screen, also referred to as the Report Generator. This mostly generic reporting interface allows you to set up complex filtering and sorting options for each report.

Each setup screen consists of two main sections.

1. Report Setup Navigator
2. Report Setup Toolbar

Report Setup Navigator

Let the Navigator be your Guide! Use the Navigator to:

- Define specific settings using the General Settings page
- Filter the initial population using available Listers
- Choose which reports to display using the Report Selection
General Settings

The General Settings page contains five distinctive sections for all reports, as follows:

Session Name

TOPSpro Enterprise assigns the Name to the reporting Session based on the report generated. This includes the date and time the report was generated and the logged-on user.

Common Filters

As the section title implies, Filters in this section are Common for many reports.

Date Ranges

The combination of Data Ranges varies depending on the type of report you are generating.
Output Layout Parameters

Settings in this section are specific to the type of report you are generating.

Special Options

Most reports include Special Options to filter the report further. These options can be very helpful to target a specific segment of the learner population. Settings in this section vary depending on the type of report you are generating.
Listers Selection

The **Navigator** gives access to lists of records as each **Lister** name indicates to include in the report.

After applying any settings for your report in **General Settings**, then select a **Lister** to filter for classes, students, assessments, etc. before generating the report.

Report Selection

The **Report Selection** lists the available sub-reports or related outputs that apply to the primary report you are generating. With certain reports, you can use this list to have the results saved to a spreadsheet.

**Report Setup Toolbar**

1. Specify the base **Container**: an agency, a site, or a state (all agencies from that state)
2. Specify if the report will **Aggregate** data or not (combine all learner records into one)
3. Specify if the report will include **Subsites** or not
4. **Generate** a reporting session to display the report in the **Report Viewer**
5. Return to the report page from any screen with **View Reporting Session**
6. **Edit Parameter** settings for filtered reports and **Load Saved Parameters**
7. **Edit** general settings and save the **Schema** to retrieve and generate again
8. **Design** the general settings page
9. Use **Pages** to clear all pages open on your screen at the same time or close specific pages
Report Generator

Report Viewer

The Report Generator displays reports in a Report Viewer. In ‘TE’ terms, a generated report is a ‘Reporting Session.’ When the report generates, a new tabbed page opens displaying the report with a Toolbar along top of the report with several options for viewing and the report displayed.

Reporting Session Toolbar

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td><img src="image1.png" alt="Export Screen" /></td>
<td>• <strong>Export</strong> the displayed report to a file on the local machine. The default file type is PDF. Use the File Explorer window to change the file type. <strong>Export</strong> to save as a PDF file, or other file type, on the local machine.</td>
</tr>
<tr>
<td>2.</td>
<td><img src="image2.png" alt="Print Screen" /></td>
<td>• <strong>Print</strong> the report on a local printer.</td>
</tr>
<tr>
<td>3.</td>
<td><img src="image3.png" alt="Layout Settings Screen" /></td>
<td>• <strong>Layout Settings</strong> displays the Output Layout Parameters section in the Report Viewer. Change <strong>Layout Settings</strong>, and then use <strong>Apply</strong> to generate the report again.</td>
</tr>
<tr>
<td>Step</td>
<td>Screen</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>4.</td>
<td><img src="image1.png" alt="Fit Page" /></td>
<td>• <strong>Fit Page</strong> displays the whole page on the screen. Use to zoom the document so you can see the entire page in the report viewer.</td>
</tr>
<tr>
<td>5.</td>
<td><img src="image2.png" alt="Fit Width" /></td>
<td>• <strong>Fit Width</strong> displays the report so that the page matches the width of the window. This is the default display after generating a report. Use Fit Width to return to the default display after using other display options.</td>
</tr>
<tr>
<td>6.</td>
<td><img src="image3.png" alt="Two Pages" /></td>
<td>• <strong>Two Pages</strong> will zoom the report so you can see two pages displayed side-by-side in one window. This also enables two-page scrolling.</td>
</tr>
<tr>
<td>7.</td>
<td><img src="image4.png" alt="Thumbnails" /></td>
<td>• <strong>Thumbnails</strong> applies a bar to the right of the report viewer with miniature displays of each page in the report. Thumbnails enable you to toggle through many pages on the screen at once. Add Thumbnails when displaying reports as <strong>Fit Page</strong>, <strong>Fit Width</strong>, and <strong>Two Pages</strong> views.</td>
</tr>
</tbody>
</table>
### Step 8
**Screen**

- **Show Summaries** identifies all cells displayed on a report with **Drill Down** to data functionality.

![Show Summaries](image1.png)

### Step 9
**Screen**

- **Edit Session** returns you to the **General Settings** screen for you to edit any settings and then generate the report again.

![Edit Session](image2.png)

---

### Saving Reports

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 10.  | ![Reports Manager](image3.png) | **Keep Session** saves an electronic copy of the report in the **TE Reports Manager**.*
When clicked, the **Report Viewer** closes immediately (without warning!) and returns to the **Report Setup Screen** automatically. |

*Tip! Before saving reports in TE, use **General Settings** to **Name** the report to help locate in the **Reports Manager**.

| 11.  | ![Refresh](image4.png) | **Refresh** will update the report if any data changed or new data was added while displaying the report in the **Report Viewer**. |
Using Drill Down

The Drill Down function in TE allows you to get at data displayed in reports. To drill down through a series of lists means to go through the hierarchy of data to find a specific record. This is a very beneficial feature to make corrections to data or add missing data on an ad hoc basis. The Report Viewer enables you to move from the summary information displayed on a report to detailed data by focusing on a specific data element. For example, if a birth date is missing, using drill down will take you to the student Demographics record to add the date of birth and then generate the report again to confirm the change.

Displaying Data as Charts and Graphs

Reports for quantitative information and comparative data include the option to generate a report with text only, as a pie chart, a bar chart, or both. Use Output Layout Parameters from General Settings to select the type of chart or graph before generating the report.
Printing Reports from Listers

The **Print** function in **Listers** enables you to create ad hoc reports of the records listed. These ad hoc reports cannot be saved in the TE Reports Manager.

### Step 14

**Screen**: 
Use Lister columns to **Filter** and **Sort** the records you want to include in an ad hoc report.

### Step 15

**Screen**: 
To print the filtered/sorted list,
- Click **Print** from the **Toolbar** at top of the list of records.
- If needed,
  - Set **Print Size**.
  - Select and order **Columns**.
- Before printing,
  - Click **Preview**.

### Step 16

**Screen**: 
A tabbed page will open to display the report.
- From **Preview**, the report may be,
  - **Printed**, or
  - **Exported**
    - Saves the report as a PDF file type by default on the local machine, or
    - You may choose a different file type before saving the ad hoc report.
Reports Manager

The Reports Manager is a virtual file cabinet that you have access to at any time, and from any location with Internet access to retrieve your saved reports.

My Reports

The My Reports menu will become available after you set up shortcuts to your favorite reports using the Report Locator Wizard.

Report Locator Wizard

The Report Locator Wizard menu becomes available after you set up shortcuts to your favorite reports using the Report Locator Wizard.
Generating Instructional Reports

Reports from TE Online are always available for teachers to generate for their class. The CASAS eTests report category gives teachers access to reports directly related to web-based testing. The Test Results report category gives teachers access to performance reports for students and classes. The State Reports category gives teachers access to monitor student gains (currently available for CA only).

Whenever teachers select any report from the Reports menu, they are presented with the Report Setup screen, also referred to as the Report Generator. Each setup screen consists of two main sections.

1. With the Report Setup Toolbar along top of the setup screen, you can Generate the report.

2. With the Report Setup Navigator, you can:
   - Define settings using the General Settings page.
   - Filter the initial population using available listers.

With the report displayed, use the Toolbar to,

- Print.
- Export to save as a PDF, or other file type, on the local machine.
- Keep Session to save an electronic copy in the TE Reports Manager.

Tip! Before saving reports in TE, use General Settings and Name the report.

- Click Edit Session.
- Edit the Session Name in General Settings.
- Click [Re]Generate.
- This will help to locate the report in the Reports Manager.
Next-Assigned Test (NAT)

Access TE: Reports > CASAS eTests > Next-Assigned Test

TE TIP!
1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment.
2. Use the Navigator to select a Class Instance and generate the NAT.

This report is designed to take the legwork out of deciding which test to administer to individual students. TE makes this process easier with the Next-Assigned Test (NAT) report.

TE searches the database to find the last test a student took in all classes across sites. Based on the form and score of the last test taken, TE assigns the next test form for tests in each modality that a student tested in such as reading, math and listening.

This report should be used along with other measures, such as hours of instruction, student class work, and teacher judgment. Administrators, database managers, and teachers should remember that the number of hours of instruction between pre- and post-test might affect a decision to post-test with the NAT or override the NAT at the same level or at the next higher level. In addition, the following should be taken into consideration:
- CASAS does not recommend a lower level form at post-test unless the pretest score was inaccurate.
- Extended range forms (081RX or 082RX) are utilized differently than other forms because they are measured across levels.
Personal Score Report (PSR)

Access TE: Reports > Test Results > CASAS eTests > Personal Score Report

TE TIP!

1. Use the Navigator to select a Test and generate the PSR.

This is a copy of the Personal Score Report that students see displayed on the testing station screen after ending a test. Information displayed to the student may be customized to remove the levels bar and skills description.

The report gives a summary of the student’s results on a given form to provide them with immediate feedback after completing a test.

This is an optional report in eTests and if enabled, students may print the PSR.
Skills Profile Reports

Student Individual Skills Profile (ISP)

Access TE: Reports > Test Results > Skills Profile > Individual Skills Profile

TE TIP!

1. Use the Navigator to select a Student from In Program Years and generate the ISP.

The Individual Skills Profile (ISP) shows how an individual student performed on the most recent reading, math, and listening test.

The report displays the CASAS Competency Content Areas and CASAS Basic Skills Content Standards Categories assessed for each test modality.

The Skills Profile identifies by percentage the number of competencies within a content area the student answered correct; and by percentage, the number of underlying basic skills embedded in CASAS Competencies.

At far right is an optional setting that you may add to the report to indicate Grade Level Equivalency.

The HSE Predictor is included in the report when a test modality score is 236 and above to indicate the likelihood of the student passing a High School Equivalency Exam.

ACTIVITY:

1. Drill down to Test Item and Competency
2. Drill down to Test Item and Content Standard
Skills Profile – Class Summary (ISPS)

Access TE: Reports > Test Results > Skills Profile > Individual Skills Profile Summary

**TE TIP!**

1. Use the **Navigator** to select a **Class Instance** and generate the **ISPS**.

The **Individual Skills Profile (ISP) Summary** shows how groups of students performed on the same form level with their most recent reading, math, and listening test.

As with the **ISP**, this report also displays **CASAS Competency Content Areas** and **CASAS Basic Skills Content Standards Categories** assessed for each test modality at the given form level.

The **Skills Profile** identifies by percentage the number of competencies within a content area, and by percentage the number of underlying basic skills embedded in CASAS Competencies that the students answered correct.

**ACTIVITY:**

1. Drill down to **Form Level** to see the list of student functioning at that level.
2. Drill down to **Total Tests** to see the list of tests students took at the Form Level.
Content Standards

Content Standards Reports

Content Standards – Student Performance (SCS)

Access TE: Reports > Test Results > Content Standards > Student Content Standard Performance

**TE TIP!**

1. Use the Navigator to select a Test and generate the SCS report with its default Layout setting for Test & Content Standard.

The Student Performance by Test & Content Standard report is similar to the Student Performance by Test Item & Competency report except this report indicates the students’ performance in each content standard by showing the percentage of correct responses to items that relate to each basic skills content standard.

The SCS report has two Layout options.

1. Test & Content Standard (default)
2. Test Item & Content Standard
**Content Standards – Student Performance (SCS)**

Access TE: Reports > Test Results > Content Standards > Student Content Standard Performance

**TE TIP!**

1. Return to the Report Setup Screen and select Test Item & Content Standard for the Output Layout.
2. Regenerate the SCS report.

This alternate version of the Student Performance by Test Item and Content Standard report combines both competencies and associated basic skills content standards on the test in one report.

- Each row contains a reading content standard.
- The columns contain a test item and corresponding competency number(s).
- Each check mark indicates the student’s correct response to the test item that relates to that particular content standard.
- Each red “X” indicates the student’s incorrect response to the item relating to the content standard.
Content Standards – Class Performance Summary (SCSS)

Access TE: Reports > Test Results > Content Standards > Content Standard Performance Summary

**TE TIP!**
1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment.
2. Use the Navigator to select a Class Instance and generate the SCSS.

The Class Performance by Test & Content Standard report is also similar to the Class Performance by Test Item & Competency by giving a summary of how students in the class performed on a given test. With this report, instructors are able to see a percentage by which each item or each content standard was successfully completed by the students who took the form.

How to use:

- Teachers can determine from the report the basic skills content standards in which the students performed well.
- Teachers use this report to inform instruction and plan lessons to target areas of need to prepare students for the next testing cycle.
- Teachers can identify the students who took a given test and group instruction to work on content standards the students need most to learn.
- Teachers can share the results with the class as a whole.

**ACTIVITY:** Drill down to the list of students who completed a given form.
Competency Performance Reports

Competency Performance – Student (SCP)

Access TE: Reports > Test Results > Competency Performance > Student Competency Performance

TE TIP!

1. Use the Navigator to select a Test and generate the SCP report.

The Student Performance by Test Item & Competency report shows how an individual student responded on a given test form. This report displays by test item the competency number and statement, the task area for how the item was presented, and if the student answered the item correct.

This is an excellent report to give to individual students to provide them with feedback for their performance on the test and the life skills competencies they need to learn.

Competency statements can be more meaningful to students than raw or scale scores.

How to use:

• Target weak areas of understanding.
• Spend less time on mastered competencies.
• Evaluate retest needs if the sale score falls below accurate range, or the student ran out of time to complete the test.
• Use the report to discuss the competency areas of need with the student.
Competency Performance – Class (SCPS)

Access: TE > Reports > Test Results > Competency Performance > Competency Performance

Summary

TE TIP!
1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment.
2. Use the Navigator to select a Class Instance and generate the SCPS.

The Class Performance by Test Item & Competency report gives a summary of how students in the class performed on a given test.
- Identifies the position of each test item on the form.
- Indicates the percentage by which the number of students who took the form answered correct.
- Includes the competency number and statement assessed per test item.
- Specifies the task area for presenting each test item.

With this report, an instructor is able to see a percentage by which each item, or each competency, was successfully completed by the students who took the test.

How to use:
- Teachers use this report to inform instruction and plan lessons.
- Teachers also use this report to target the areas of greatest need to prepare their students for the next testing cycle.
- Teachers can identify the students who took a given test and group instruction to work on competencies the students need most to learn.
- Teachers can share the results with the class as a whole.

ACTIVITY: Drill down to the list of students who completed a given form.
Learning Gains Reports

Learning Gains – Student (LG)

Access TE: Reports > Test Results > Learning Gains > Student Learning Gains

**TE TIP!**

1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment.
2. Use the Navigator to select a Class Instance and generate LG with its default settings.

The Learning Gains First to High report computes progress (or setbacks) from the first test to the highest test given (in any class at any site) for a particular student.

The first test from which progress is measured is considered the anchor test. If a student changes classes several times, TE will locate the student’s highest test and match it with the first test.

The benefit is that a teacher does not need to know all other classes the student is taking to compute the gains.

TE also matches tests by form type. For example, if a student takes reading, listening, and math test, the report generator will selectively match reading tests to reading tests, listening tests to listening tests, and math tests to math tests.

**How to use:**

- Use this report to determine the highest gain a student (or the class as a whole) received on a particular form type across classes.
- Use this report to see which students have a pretest, but no post-test.
- Use this report to see which students should be retested due to invalid test scores or high end conservative estimate scores.

**ACTIVITY:** Generate the report again using any of the other Learning Gains Types.
Learning Gains

Learning Gains – Class Summary (LGS)

Access TE: Reports > Test Results > Learning Gains > Learning Gains Summary

TE TIP!
1. In General Settings > Output Parameters Layout, set Display Mode.
2. In General Settings > Special Options, set Display Class Based On > Class Enrollment.

Use the Navigator to select a Class Instance and generate the LGS.

This report is designed to show, by Instructional Program and Modality (Reading, Math, Listening), the average gains (or setbacks) achieved between the scale scores of the First and the Last tests taken (not necessarily highest) within a defined period.

How to use:
- Determine the greatest amount of testing being done in different modality areas and Programs in a class.
- Administrators can see how well, on the average, that gains are being accomplished from class to class for each Instructional Program by modality.
- Teachers can compare their own class Learning Gains reports with other classes to see how well their own students compare.

ACTIVITY: Drill down to the list of students who took the tests.
Test Response Reports

Test Response – Class Profile (CPL)

Access: TE > Reports > Test Results > Test History > Student Test Summary

**TE TIP!**

1. Use the Navigator to select a Class Instance (for test) and generate the CPL.

The Class Profile is a legacy report that is also included as a worksheet in some older Test Administration Manuals. This report requires a class assigned to the test record for the report to generate.

The Class Profile report shows teachers how individual students answered questions on specific tests within a specific class. The Class Profile report gives information at a glance on:

- Individual student achievement
- Class average
- Total number of students
- Correct (+) and incorrect (-) item responses as well as blank (!) responses
- Competency number for each test item
- Scores outside of accurate range (*)

**How to use:**

- Determine if all students have mastered specific competencies
- Determine competencies that still need attention
- Identify students who have taken the same test twice within the date range (listed twice)
Test History – Student Test Summary by Class (STS)

Access TE: Reports > Test Results > Test History > Student Test Summary

**TE TIP!**

1. In **General Settings > Special Options**, set **Display Class Based On > Class Enrollment**.
2. Use the **Navigator** to select a **Class Instance** and generate the **STS**.

The **Student Test Summary by Class** report lists every student that has taken a test in the selected class and displays test history for each student.

Tests are listed in test date order for each student.

The report displays test date, the specific test given (Form number), scale score, and cumulative hours of instruction.

The report also identifies test scores below the accurate range with an asterisk (*) and high-end conservative estimate scores with a diamond symbol ().

**How to use:**

- Identify all tests each student has taken in a class.
- Identify test scores that are invalid (asterisk) in a class.
- Identify students who have taken a specific test (Form Number) in a class.
- Sort tests by form number to see what students have taken each test.
Steps to Exit TE

To ensure data is secure and confidential and that unauthorized personnel are unable to gain access to personal data, it is important to disconnect from the server before exiting TE.

<table>
<thead>
<tr>
<th>Step</th>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | ![Close All Pages](image) | - When you are finished working in TE, or at any time you have several tabbed pages open,  
  - Click **Pages** at top right.  
  - From the drop-down menu,  
    - Click **Close All Pages**. |
| 2.   | ![TE Icon Disconnect](image) | - At top left of your screen,  
  - Click the TE icon.  
  - Or click **Disconnect**. |
| 3.   | ![Red X Box](image) | - Click the TE icon again.  
  - Click **Exit**.  
  - Or click the **Red X Box** at top right of your screen. |
CASAS Contact Information

Mail: CASAS
      5151 Murphy Canyon Rd., Suite 220
      San Diego, CA 92123-4339

Website: www.casas.org

Telephone: (858) 292-2900 or toll free (800) 255-1036

Fax: (858) 292-2910

E-mail:

General questions: casas@casas.org
Training questions: training@casas.org
Ordering questions: orders@casas.org
Field Testing Opportunities: fieldtesting@casas.org
CASAS Technology Support Team: techsupport@casas.org

Training Support

Contact the Training Team at training@casas.org.

Enroll in online training at http://training.casas.org/.

Access help documentation:
- eTests Online Help
- TOPSpro Enterprise Help

Technical Support

The CASAS Technology Support Team is available to provide assistance using eTests and TE.
- Email Anytime: techsupport@casas.org
- Phone Support: (858) 292-2900 or toll free (800) 255-1036, option 2
  - 6:00 am – 5:00 pm (Pacific Time)
  - Monday – Friday